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Modeliranje ljuskaste konstrukcije
konacnim elmentima
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Postavka zadatka

Rezervoar za gorivo ukupne duzine L=5000
mm, spoljasnjeg precnika D=1000 mm je
izraden od celichog lima debljine s=10 mm.
Gorivo u rezervoaru je pod pritiskom p=1
MPa. Odrediti maksimalna pomjeranja i von
Mises-ove napone. Rezervoar je slobodno
oslonjen o tlo. Detaljni podaci o geometriji |
dimenzijama danca rezervoara su prikazani
na slici.
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Postavka zadatka

Detaljni podaci o geometriji | dimenzijama danca
rezervora: R=1000mm, h,=190mm, r=100 mm
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Posuda pod pritiskom
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Modeliranje ljuskaste konstrukcije

Aktivirati program ANSYS i sacCuvati prazan
projekat pod nazivom Rezervoar
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Modeliranje ljuskaste konstrukcije

Kreirati
Structural)

staticku

linearnu  analizu Static
na shemi projekta (Project Shematic
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Modeliranje ljuskaste konstrukcije

lzvrsSiti podesavanja modula Design Modeler
(Geometry->Properties->Analysis Type = 3D)

A
7 Static Structural
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I@ Geometry —= 1
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Modeliranj

e ljuskaste konstrukcije

Aktivirati modul Design Modeler (Geometry-
>New Geometry)

A

7 Static Structural

EngineeringData "

@ A: Static Structural - DesignModeler

v
1
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3 I. Geometry = |
O M ) MNew Geometry...
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Modeliranje ljuskaste konstrukcije

Podesiti duzinske jedinice (Units->Meter)

&) A: Static Structural - DesignModeler

- X
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e . = -
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Modeliranje ljuskaste konstrukcije

UCitavanje eksterno generisane geometrije (File-
>Import External Geometry File) *.sat format

- X

e

FINEEILCOL L RE
olgz|z|zs|3HE|gss ¢ @
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Refresh Input T RRER - EE||SECQAQARQAQA T |k Ge (12| B W~ A~ A S A A A~
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Modeliranje ljuskaste konstrukcije

UcCitavanje eksterno generisane geometrije
okoncati komandom Generate

| File Create Concept Tools Units View Help
[ QE B[ @] D Greis [|soc
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Modeliranje ljuskaste konstrukcije

Aktivirati modul Static Structural (Model->Edit

A

4

8l = Static Structural

2 | @ EnginesringData v

3 @) ceometry

V'

4| @ Moo |
5 e Setup

6 & Solution
7 @ Results
Static Strug

1|
Edit...

@

=3

Duplicate
Transfer Data From New
Transfer Data To New

Update

Clear Generated Data
Refresh

Reset

Rename

Properties

Quick Help

Add Mote
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| 7 Show Vertices B Wireframe | 2 <how 1o & |l Random Colors @5 Annotation Preferences

Filter Name
{8l Project
&
B8 Geometry
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v Coordinate Systems
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7 Analysis Settings
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Details of "Model" il
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Modeliranje ljuskaste konstrukcije

Podesiti debljinu zida

rezervoara Detalls

Geometry->Definition->Thickness na 0.01m

@D A : Static Structural - Mechanical [ANSYS Muitiphysics]
| File Edit View Units Tools Help || @ =% | “fSove ~ ?/ShowEmors tll b (@ & [A] (@~ @ worisheer dn

[FAYER-VC-EAEE &sQQ QEAAQAENGE DO

| Show Vertices @2 Wireframe | 4, t10

ek A M Random Colors 5 Annotation Preferences

| M EdgeColoring v A~ A~ A~ A~ A~ A Pl |- Thicken Annotations

| Geometry it iy | PyPointMass % Thermal Point Mass  wBThick wi Imported Thicknes:  WBLayered Section | B |
Outline 2
Filter: Name - 2

--9[=] Static Structural (A5)
7 Analysis Settings
El- 7 Solution (A6)
-] Solution Information

Details of "Part 1"
[+ Graphics Properties A
= Definition
Suppressed No
|Stiffness Benavior | Flexible

Coordinate System Default Coordinate System

ce Temperature

|offset ype Middle 0.00 1000.00 2000.00 (m)
‘Materi [ EEaaa— S
=1 Material
| Assignment Structural Steel 0000 foo00
Nonlinear Effects Yes

A Print Preview )\ Report Preview /.

Thermal Strain Effects | Yes

1 Rewsnding Row.

Timestamp
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Modeliranje ljuskaste konstrukcije

Definisati veliCinu konacnih elemenata Mesh-
>Insert->Sizing

@ A Static Structural - Mechanical [ANSYS Multiphysics] - pd
| File Edit View Units Tools Help || @ =% | fSolve v 2/ShowEmors Hl Wt (4] 4 [A] (@ v (J7Worksheet ix
1 RAYR-C-EAERARAE & /sPPAQARQAQEQAQRE 2 E DO | B Show Vertices #@Wireframe | "% 5how ek A& o Random Colors @ Annotation Preferences

| M EdgeColoring v £~ A~ A~ A~ A~ A Pl |- Thicken Annotations

|Mesh =/ Update | @ Mesh v @, Mesh Control w | (| /vietr

rap

Filter: Name

8, Contact Sizing

<} Generate Mesh

Preview
Show
<} Create Pinch Controls

: [ Mapped Face Meshing
g Match Control

@ Pinch

] Clear Generated Data A Inflation

<lb Rename (F2)

Details of "Mesh" Start Recording

= | Defaults
Physics Preference Mechanical
Relevance 0
5 Sizing ® Lt
= Patch Conforming Options.

Triangle Surface Mesher | Program Controlled

= Patch Independent Options

Topology Checking | Yes 0.00 1000.00 2000.00 (m)
| EEaaaa—— S

5[ Advanced

500.00 1500.00

APrint Preview )\ Report Preview/. ]
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Modeliranje ljuskaste konstrukcije

U polje Details of Sizing->Element Size unijeti
0.04 m. lzabrati svih 5 povrsina i aktivirati Details
of Sizing->Geometry->Apply

@ A: Static Structural - Mechanical [ANSYS Muitiphysics] — X
| File Edit View Units Tools Help simg@ % | Sove v 2/ShowEmors il Wi [ 4 [A] @~ (JWorksheet in
R AR W -SSP a QA2 E D O | 7 Show Vertices #@Wireframe | % Show ivesh & Il Random Colors 25 Annotation Preferences
Bl Edge Coloring v £~ A~ ,gv A~ A Pl |- Thicken Annotations

|Mesh -/ Update | @ Mesh v @ Mesh Control v | (| 1viet
Outline

B+

Filter: Name »
@) Project
- (g Model (Ad)
B A Geometry
SR Part1
-2 Coordinate Systems
- Mesh
B, Face Sizing
[=-9[2] Static Structural (A5)
/N Analysis Settings
19| Solution (A6)
3] solution Information

=l Scope

Scoping Method Geometry Selection | — {
Geometry 5 Faces | s )
=1 Definition T [/
Suppressed No | y
| Y
Behavior Soft |
| 000 1000.00 2000.00 (m)
| EEaaaa—— S
Growth Rate Defautt
Local Min Size Default (0. m) 50000 1a0.00

A Print Preview ) Report Preview/
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Metric (m, kg, N, 5, V, A) Degrees rad/s Celsius
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Modeliranje ljuskaste konstrukcije

Generisati

mrezu konacnih elemenata Mesh-

>(Generate Mesh

(MBS

| File Edit View Units Tools Help

@ | fSole v 2/Showkrors T W [ 4 [A] [@] v [@PWorksheet iy

- a X

(R AR -EDER @ S Q@A g s o0

| 7 Show Vertices  @@Wireframe | ;i # & M Random Colors @) Annotation Preferences

| M EdgeColoring v A~ Av A~ Av A~ A Pl |-l Thicken Annotations

|Mesh =/ Update | @ Mesh ~ & Mesh Control ~ |

Outline

Filter: Name »
@] Project
- @] Model (A4)
B8 Geometry
xR Part1
-y Coordinate Systems
- A8 Mesh
/B, Face sizing
[=-9[2] Static Structural (A5)
/7y Analysis Settings
E- 9@ Solution (A6)
(3] solution Information

B+

10268

10280

Details of “Mesh L3
=) Defaults ~
Physics Preference Mechanical

| Relevance lo 4‘4[%
[+ Sizing A\ fF
1+ | Inflation o
=) Patch Conforming Options ®

i]vl}ﬂglg Sur!a(g Mefllll 1 Program Controlled Y
= | Patch Independent Options

[Topology Checking | Yes 0,000 0500 1.000(m)

o - N
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APrint Preview ), Report Preview/
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Studijski program Masinstvo — Konstruisanje pomocu racunara



Modeliranje ljuskaste konstrukcije

Dodati opterecenje od pritiska Static Structural-
>Insert->Pressure

@ A: Static Structural - Mechanical [ANSYS Multiphysics] — %
| File Edit View Units Tools Help || @ <+ | JfSolve ~ ?/ShowErmors Tl 0 [Q 4 [A] (@~ @ worhee g
[ RAYER-R-EARARE S SPRAAQAIQREAAQAE LI E (O | 7 Show Vertices gRWireframe | T Show Mesh 4 Il Random Colors 73 Annotation Preferences

| MEdgeColoring v £~ Aiv A+ A~ fi~ A || |~IThicken Annotations
| Environment S Inertial v @ Loads v @ Supports ~ @ Conditions v @, DirectFE ~ | B

Filter: Name -
(@] Project

- [g| Model (A4) @1 Acceleration
- /8 Geometry i .
« By Part 1 @] Standard Earth Gravity
-+ Coordnate Systems @, Rotational Velocity
-, & Mesh
SR ] Static Sp== L &, Hydrostatic Pressure
TR
E78l g @, Remote Force
’ @, Bearing Load
] Clear Generated Data % Bolt Pretension
ab Rename (F2) @, Moment
A Open Solver Files Directory S, Line Pressure
@) Thermal Condition
% Joint Load
Details of “Static Structural (AS)" a | | % Fluid Solid Interface
5| Definition B @, Fixed Support
Physics Type Structural @ pi
Analysis Type Static Structural 3' = 7
Solver Target Mechanical APDL 5
e S @, Frictionless Support
Environment Temperature [22.°C b c_Y”"‘"i“' Support 'Y
Generate Input Only | No . Simply Supported Y.
@), Fixed Rotation
@, Elastic Support 0.000 0500 1.000{m)
—_— [ EEmmm "
@, Constraint Equation 0250 0750
1\ G ® Noda! Orientation Niew/ ]
G - Nodal Force B =
= a5 @, Nodal Pressure
g ’_ &, Nods! D
EEER @, Nodsl Rotation
| ] @, EM Transducer
[ & Motion Losd |0 No Messages No Selection |Metric (m, kg, N, 5,V, A) Degrees rad/s Celsius 7

B Commands
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Modeliranje ljuskaste konstrukcije

|zabrati svih 5 povrsina i aktivirati Details of
Pressure->Geometry->Apply

G A: Static Structural - Mechanical [ANSYS Multiphysics] s X
File Edit View Units Tools Help || @ =% | </Solve v ?/ShowErors Tl W& [0 4 [A] @~ Byvor i
® AW Ry L DB/ & SHPaQaea@aaXnegs o0 5 Show Vertices gQWireframe | T Show Mesh & Il Random Colors 5 Annotation Preferences.

Wl EdgeColoring v £~ A~ A~ A~ fi~ A bl |-l Thicken Annotations
| Environment @k Inertial v @k Loads v @k Supports v @ Conditions v @ DirectFE v | B
Outline 2
Filter Name - 6]
] Project
= g Model (Ad)
B, B Geometry
x® Part 1
@2k Coordinate Systems
= 8 Mesh
B, Face sizing
=9[2] Static Structural (A5)
7 Analysis Settings
2%, Pressure
El--9/@| Solution (A6)
#(3] Solution Information

= Scof
coping Method | Geometry Sel
< Geometry 5 Faces

Type Pressure
Define By Normal To ™
Magnitude | 0. Pa (ramped) | Y
Suppressed No
0.000 0500 1.000¢m)
0250 0750
APrint Preview ), Report Preview/ 1
Graph 2 Tabular Data
Section Planes 2 x Steps | Time [s] [[¥ Pressure [Pa]
¢ [ 11 o 0.
EEER Rl | 0.
| Messages Graph g

.0 No Messages No Selection Metric (m, kg, N, 5, V, A) Degrees rad/s Celsius

1:46 PM
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Modeliranje ljuskaste konstrukcije

Podesiti intezitet pritiska Details of Pressure-
>Definition->Magnitude na -1e6 Pa da bi pritisak
djelovao sa u}nutraénje strane rezervoara

@ A Static Structural - Mechanical [ANSYS Multiphysics — X
file Edit View Units Tools Help || @ =% | fSolve v 2/ShowErors i mf [ (A @~ 8 i
RAOATYER--RE® o5 P Q| QaFEnegs | 0O F Show Vertices g Wireframe | Show Mesh & Il Random Colors > Annotation Preferences

W Edge Coloring £~ A~ A~ A~ A~ A Pl |-l Thicken Annotations

Environment @k Inertial v @ Loads v @k Supports v @ Conditions v @, Direct FE v | B

Outline 2
Filter: Name v 2
@) project
= (@] Model (A4)

= Geometry

x| Partl
By Coordinate Systems
-, Mesh

B, Face Sizing
[2) Static Structural (A5)
/7Y Analysis Settings
o JB, Pressure
E-/[@) Solution (A6)
(1] solution Information

o}

Details of “Pressure” bl
= Scope
Scoping Method | Geometry Selection

Geometry 5 Faces

= Definition z
Type Pressure
Define By Normal To
-1.e+006 Pa (ramped) J
Suppressed No
0.000 0500 1.000(m)
[ EEaaaa—— [ ESSSS—
0.250 0,750
A Print Preview ) Report Preview/ |
Graph T Tabular Data
Section Planes 2 x Steps | Time[s] [[¥ Pressure[Pa] | Py
.« ______________________________|] i1 o 0.
L i ] B
‘ ] e 21 |1 -1.e-006
[ | - Messages Graph al v
0 No Messages 5 Faces Selected: Surface Area(approx.) = 16.225 m* Metric (m, kg, N, 5, V, A) Degrees rad/s Celsius

e 9 =B L 9 ﬁ wi x1 ] . | m "‘ ﬁf‘l £ i & 1) @ SRP 5};?:,:;:0 =]
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Modeliranje ljuskaste konstrukcije

|zabrati analizu koja se zeli realizovati Solution-
>Insert->Total Deformation / Equivalent Stress

@ A: Static Structural - Mechanical [ANSYS Muitiphysics] — X
File Edit View Units Tools Help || @ =% | 3¢Sove ~ ?/ShowEmors Hll Wt [ & [A] @~ B vor i
B W R R WER & /st eEaanagas | O 7 Show Vertices ¢ Wireframe | T Show Mesh ;& Il Random Colors @ Annotation Preferences

WM EdgeColoring v £~ A~ A~ A~ A~ A Pl |-l Thicken Annotations
| Solution B, Deformation v @ Strain v @, Stress v @ Energy v | @, Damage v | @ Linearized Stress v | @ Probe v (@] Tools v | @, User Defined Result

| @, Coordinate Systems v [

Filter: Name v 2
@) Project
= [ Model (Ad)
- A Geometry
x® Part 1
-2 Coordinate Systems
/8 Mesh
B, Face Sizing
=-/|2] Static Structural (A5)
/N Analysis Settings
-/ P Pressure

o o R S o

»
/B Tol -/ solve Deformation :
>

Strain

ress

LN Equivalent (von-Mises)

] Clear Generated Data

b Rename (F2) | Energy » |8, Maximum Principal
2 Open Solvet Files Directory | Linearized Stress » 2 Middle Principal
|5 Opeaoiver ofes Dieechory. | N '
Details of “Solution (A6)" %[ Fatigue = 5 xlnlmum ::nclpa
1 i
I Adaptive Mesh Refinement e ——— N St
Max Refinement Loops | 1. ‘% Intensity
Refinement Depth |2, | Probe ;‘qy Normal
=1/ Information = ‘0, Shear >
Status Solve Required } Kido/iste Sysisne "1 @, Vector Principal
@, User Defined Result
> ), Error
B Commands o, e o - .
@, Bending Stress —:—:1' -
s 0250 0.750
APrint Preview ) Report Previen/ ]
Graph R Tabular Data
Section Planes 7 x
EEEL
| ] Messages Graph
0 No Messages No Selection A) Degrees rad/s Celsius

4 PM
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Modeliranje ljuskaste konstrukcije

Polje pomjeranja

@ A Static Structural - Mechanical [ANSYS Multiphysics]

File Edit View Units Tools Help || @ =48 | :/Solve + ?/ShowErors Tl W [ 4 [A] @]~ i
B-hLODl @ S At aEaaE e E o

W EdgeColoing v A~ A~ A~ A~ A~ A Pl |-l Thicken Annotations

Result [T - @~ B-®-F | ® @ | EProbe | Display Al Bodies -

Outline R

Filter. Name i :ﬂ

‘§] Project

= (@] Model (A4)

=@ Geometry

& Part 1

/>~ Coordinate Systems
80 Mesh
/B, Face Sizing
/=] Static Structural (A5)
,,7\ Analysis Settings
= ,,9.. Pressure
=/ Solution (A6)
. ,l] Solution Information
/& Total Deformation
-/ Equivalent Stress

0.00040939
0.00032962

0.00017006
9.0283e-5 Min

Details of “Total Deformation”

s X
P Show Vertices %9 Wireframe s M Random Colors %) Annotation Preferences

=l Scope A
Scoping Method Geometry Selection
Geometry 5 Faces
|| Definition z
Type Total Deformation
By Time
Display Time Last
Calculate Time History | Yes Y
Identifier 0.000 1.000 2.000(m)
Suppressed No
1.500
=/ Results
Minimum 9.0283e-005 m =
Geomet Print Preview A Report Preview,
Maximum 8.0828e-004 m ry,( }\ £ / I
=1 Minimum \aliue Ouer Time ¥ Graph ?  Tabular Data B
Section Planes 2 X || Animation | W ||11 U1 | @ 10 Frames > 2Sec(Auto) 2
EEEE
| | Messages. Graph v

O 1 Message

Metric (m, kg, N, 5, V, A) Degrees rad/s Celsius
7 PM

1/2020
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